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INTRODUCTION 

1.1 Overview  
PURLS is a sophisticated solid-state light source for monitoring the calibration stability 
of radiometers, especially those used in-situ to support Ocean Color and environmental 
research.  While specifically designed for easy and reliable use in field conditions, for 
example during oceanographic cruises, PURLS also includes capabilities far beyond 
those of previous sources used in such applications. 

 Instead of the incandescent bulbs traditionally used as radiometric standards, 
PURLS uses an array of light-emitting diodes (LEDs) to provide many advantages 
including: 

• electronically adjustable spectral balance, 
• selection among multiple independent spectra, 
• active correction of light source aging, 
• rapid warmup, 
• low power consumption 
• reduced weight and size. 

1.2 Application to Field Radiometers 
 In-situ radiometric data, especially those supporting calibration and validation of 
satellite data and research into climate change, often must meet high quality standards 
under challenging circumstances.  Typical annual calibration cycles may not be adequate 
to assure the necessary quality.  PURLS, though not a calibration standard, provides a 
simple way to detect whether radiometers’ responses change significantly between 
calibrations, especially during field operations when they may be subject to stressful 
environments and handling.   

 Ideally, the user of a radiometer will record its baseline response to PURLS’s 
stable output immediately after the radiometer is calibrated by the manufacturer or a 
qualified laboratory.  During subsequent use, either in the laboratory or field, the user 
would regularly collect data with PURLS and the radiometer in the same configuration.  
These measurements would either confirm that the radiometer is stable, indicate that it 
requires a new calibration, or demonstrate the radiometer is changing in a systematic way 
that can be tracked and compensated for with regular PURLS measurements. 
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1.3 Principles of Operation 

1.3.1 LED Array  
PURLS’s core is an array of LEDs, each driven by a software-controlled high-resolution 
current source.  While individual LEDs generate characteristic, typically narrow, bands of 
wavelengths (see Figure 1), they can be combined to produce a broad spectrum.  
Individual LEDs also differ greatly in their total output power, but because PURLS 
independently controls the drive current to each LED, it provides complete control over 
the shape of the resulting spectrum.  Figure 2 shows a balanced spectrum generated from 
the LED spectra in Figure 1, compared with the spectrum from an incandescent bulb of 
the type commonly used for radiometric calibrations.  Note that while the PURLS 
spectrum is not perfectly flat, its overall balance is far better than that of the incandescent 
bulb.  Also, PURLS supports infinite programmability of the spectral shape to suit the 
requirements of specific applications. 

Figure 1.  Spectra of various individual LEDs.  To illustrate their shapes these 
curves have been normalized to equal peak amplitudes.  In absolute power they 
actually differ by as much as an order of magnitude.  The broad curve in the middle 
portion of the spectrum is from a "white" LED. 
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Figure 2.  Composite spectrum generated by adjusting and combining the outputs of 
the LEDs shown in Figure 1, compared with that of a NIST-standard incandescent 
bulb.  While the incandescent spectrum is smooth, it varies by a factor of 17 over the 
range 365 to 850 nm, while the PURLS varies by less than a factor of 2 over the 
same range (note that the spectral range of specific PURLS may be different, 
depending on customer requirements).  PURLS can also generate different spectral 
shapes. 

1.3.2 Stabilization  
 Although LEDs have numerous practical advantages over incandescent sources, 
they are not intrinsically stable.  They are somewhat sensitive to temperature, and though 
they have very long lifetimes compared to incandescent bulbs, their outputs do gradually 
change with age.  PURLS achieves superior stability by regulating the LEDs’ 
temperature, and by actively correcting their drive currents with electro-optic feedback. 

 Temperature is stabilized by mounting the LEDs in thermal contact with a metal 
block that is insulated from the outside environment.  The temperature of this assembly is 
tightly regulated, normally at 25.0 C, by either heating or cooling depending on the 
ambient temperature. 

 To measure and regulate its optical output, PURLS contains four photodiode 
detectors within the same thermally regulated assembly as the LEDs.  The four reference 
detectors are identical except that their different positions give them different sensitivities 
to individual LEDs in the array. 

 During standard data collection, all LEDs are illuminated continuously to provide 
the best possible stability.  In this mode, the reference detectors measure the total output 
from the LED array and cannot distinguish the outputs individual LEDs.  To measure and 
regulate the outputs of individual LEDs, normally upon command from the user, PURLS 
performs a sequence of measurements during which the LEDs are switch on and off in 
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sequence, and measured in turn by each of the four reference detectors.  The timing of 
this sequence is very important, because switching the LEDs off even briefly does 
slightly affect their temperature, and therefore their output.  To avoid distortion of the 
measurements by this effect, the LEDs’ average off time is kept below 1. 

1.4 Computer Control and Advanced Functions 
 For its main purpose of monitoring radiometer stability, PURLS is simple to use 
and does not require connection to a computer.  However the supplied software provides 
very useful functions for monitoring and controlling PURLS operation with a Windows 
or Mac OS computer.  See section 4 for details. 

 PURLS also includes numerous additional commands that are accessible through 
any terminal communication software, and can even be combined into command scripts 
to support special applications.  For more information about these capabilities, please 
contact HOBI Labs support. 
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2 QUICK START 

2.1 Unpacking and Setup 
 PURLS is integrated into its own shipping container.  To open it, simply loosen 
all six exterior latches and lift off the lid.  Accessories such as cables and mounting 
collars for radiometers may be enclosed in the lid.  Use care when opening. 

 Place PURLS on a stable surface, near a source of AC power. 

2.2 Basic Operation (without computer connection) 
• Connect the PURLS line cord to100 to 250 VAC, 50 or 60 Hz. 
• Turn on the PURLS power switch.  Within 10 seconds the yellow Thermal 

Control Active light should turn on. 
• Set the Spectrum switch to 1 or 2. 
• Wait five to ten minutes for the green Thermal Control Ready and Output. 

Ready lights to illuminate continuously. 
• The light source is now stable. 
• You may change the spectrum switch at any time, but when you do, the light 

source will require a few minutes to regain its full stability (as indicated by the 
Output Ready light). 

2.3 Attaching a Radiometer 
Also see section 3.1.2. 

• Find the adapter collar supplied with the PURLS that is appropriate to your 
specific radiometer (assuming you specified that radiometer at the time you 
ordered PURLS) 

• Loosen the nut on the side of the collar until the nut turns freely (do not 
remove it) 

• Place the collar on a smooth, flat surface, that cannot damage the face of the 
radiometer 

• Place the radiometer face-down in the center of the collar 
• Tighten the nut on the side of the collar 
• Place the radiometer-collar assembly on PURLS, oriented so the holes in the 

collar align with the matching pins on PURLS. 
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2.4 Software Installation (optional) 
 PURLS does not necessarily require connection to a computer, but we 
recommend it, when possible, in order to monitor its operation.  The supplied software is 
based on IGOR Pro from Wavemetrics, Inc.  Igor Pro can be installed on either Windows 
or Mac OS X. 

 Assuming you are using PURLS to test radiometers, you will need to collect data 
from the radiometers with their normal operating software. 

 If your computer is not equipped with a built-in RS232 COM or serial port, you 
will also need a USB-Serial converter and may need to install its software drivers.  The 
details of this depend on your computer and the specific USB-Serial converter you use.  
Contact HOBI Labs support if you need advice on this. 

 To set up IGOR Pro:
• Run the installer appropriate to your operating system (Windows or OS X), 

from the supplied CD-ROM, 
• Open Igor Pro 
• Select Help->Show Igor Pro User Files.  A desktop window will open. 
• In this window, double-click on the Igor Extensions folder to open it. 
• Again in Igor, select Help->Show Igor Pro Folder 
• In the resulting window, open More Extensions \ Data Acquisition.  In this 

folder find the file VDT2.XOP. 
• Copy VDT2.XOP to the Igor Extensions folder opened above. 
• Quit Igor Pro. 

2.5 Operation (with computer) 
• Install the software as in section 2.2. 
• Connect PURLS to a serial port (or USB-serial converter) on your computer. 
• Turn on PURLS with the switch next to the line cord.  Within 10 seconds the 

yellow Thermal Control Active light should turn on. 
• Set the PURLS Spectrum switch to 1. 
• On your computer, double-click on the file PURLS Control.pxt. This will 

launch Igor Pro and open the PURLS Control panel. 
• Click on the Connect check box.  The software will search for PURLS on the 

available serial ports. 



- 10 - 

• Once PURLS is connected, the controls and indicators on the control panel 
will be updated to show the unit’s status. 

• The thermal control will typically stabilize within 5 to 10 minutes, as 
indicated by the green light on the PURLS panel and the corresponding check 
box on the control panel. 

• The light source will be considered stable within a maximum of three minutes 
after the thermal control stabilizes. 

• Experiment with the popup menu controls for displaying and exporting the 
temperature and reference data. 
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3 USING PURLS 

3.1 Front Panel 

3.1.1 Power Input 
 PURLS operates from any standard line voltage of 110 to 240 VAC, at 50 to 
60 Hz.  The input is protected from overload by two 5 x 20 mm, 1-amp slow-acting fuses, 
which are housed in the power entry module where the power cord connects.  You must 
unplug the cord to access the fuse compartment.  The fuses should never need 
replacement under normal conditions.  If they do fail, be sure to check for dangerous fault 
conditions before replacing them. 

3.1.2 Controls and Indicators 
 PURLS has a very simple set of controls, shown in Figure 3, to allow easy use 
under field conditions, without requiring a computer. 

Figure 3.  PURLS Front Panel Controls 

Thermal Control 
 The yellow Active light indicates that the thermal regulator is engaged and 
controlling the temperature.  It should normally turn on within 10 seconds after PURLS is 
first turned on, and remain on continuously. 

 The green Ready light indicates whether the temperature of the light source is 
stable and within the target range (typically 25±0.3 C).  When the temperature first enters 
the target range, the light blinks until the temperature is determined to be stable, typically 
one minute, then switches to continuous green. 

Light Control 
 The Spectrum switch selects one of two programmed spectra, or turns off the 
light source completely for dark measurements. 



Figure 4.  Radiometer Mounting Collar. 

 The Start button initiates the auto-adjust process described in section 3.4.  The 
yellow In Progress light flashes throughout the auto-adjust process. 

 The green Output Ready light illuminates when the light source is on and stable.  
The output is not considered ready if the spectrum switch is set to Dark, if an auto-adjust 
is in progress, or if the thermal control has not yet stabilized (as indicated by its own 
Ready light).  The Output Ready light flashes when the source is within three minutes of 
being ready.  This three-minute period is started over whenever the Spectrum switch 
setting is changed, or if the spectrum is changed by a software command. 

 The red Warning light flashes if you attempt to start auto-adjust before the light 
source is stable, if you abort an auto-adjust in progress, or if another error condition 
arises that prevents completion of the auto-adjust process.  In these cases PURLS will 
also send an error message on the serial port, which you can see in the Igor Terminal 
window.  If you are not connected at the time of the error, you can connect, then type 
MSG in the terminal window to view the most recent error message. 

3.1.3 Computer interface 
 If you choose to use a computer to monitor and control PURLS, its commands 
and data are transmitted via RS232 through a DB-9 connector on the front panel. The 
serial format is 8 bits, no parity.  The default baud rate is 57,600 baud, but can be varied 
from 9600 to 115,200 (see the description of the BAUD command in section 5). 

 Since most recent computers have no built-in RS232 ports, most users will need a 
USB-Serial adapter to communicate with PURLS. 

3.2 Radiometer Mechanical Interface 
 Cylindrical radiometers attach to PURLS 
through adapter collars like the one shown in 
Figure 4.  The collars are designed to provide 
highly repeatable positioning of the radiometer, 
for the most meaningful stability measurements. 

 The white index mark seen in the figure 
is provided to allow consistent rotational 
positioning in the collar.  To properly use this 
mark, the radiometer must also have a durable 
mark or strip of tape that can be consistently matched with the mark on the collar. 
- 12 - 
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The radiometer’s depth in the collar must also be consistent.  The collar in the 
illustration includes a ridge at the bottom of the center hole so that the radiometer will 
naturally rest at the correct depth.  For collars that do not have this ridge, the collar must 
be placed on a flat, solid surface (one that cannot damage the radiometer’s face) while the 
radiometer is placed face-down in it.  The flat surface will ensure the collar rests flush 
with the end of the radiometer. 

 The alignment holes in the collar match precisely placed and sized pins protruding 
slightly from the PURLS face.  After the user carefully mounts the collar around the 
instrument and tightens the clamping nut, the assembly is placed onto the PURLS and the 
holes aligned with the matching pins.  Then the four spring-mounted screws on the 
corners of the collar are tightened to hold it in place. 

3.3 Radiometer Mounting Procedure 
 For repeatable results, it is very important to use careful and consistent procedures 
when attaching radiometers to PURLS.  Users may have to adapt some details depending 
on the specific radiometers they are using, but the following procedure generally applies: 

• Loosen the collar’s clamping nut (but do not remove it). 
• Place the collar on a flat, smooth surface, with the index mark and the spring-

loaded screws on the top. 
• Place the radiometer into the center hole, and rotate it so the index mark on 

the collar matches a consistent mark on the radiometer. 
• Check that the radiometer is resting stably at the bottom of the hole. 
• Tighten the clamping nut (only with your fingers!) 
• Place the assembly onto the PURLS, carfully matching the alignment holes 

with the pins on PURLS. 
• If properly positioned, the collar should rest flat against the face of PURLS.  

Press the collar gently against the alignment pins to take up any slight 
looseness, and tighten the four spring-loaded screws (only with your fingers!) 

• For the best possible repeatability, tighten the screws in the same order every 
time. 

3.4 Auto-Adjust 
 Auto-adjust is the process by which PURLS measures the output of each of its 
LEDs, and if necessary adjusts their currents to compensate for aging and drift.  This is 
key to PURLS’ long-term stability, but because it requires modulating the LEDs, which 
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could cause errors for some types of radiometer measurements, PURLS only executes the 
auto-adjust process when instructed by the user. 

 For critical applications we recommend using auto-adjust every few hours of 
PURLS operation. 

 The auto-adjust process takes roughly four minutes to execute, but requires no 
user input once it is set up and initiated.  The setup consists only of installing the black 
cover over the PURLS output window.  This is very important because external light, and 
even the light reflected from objects near the window, can significantly affect the auto-
adjust results.  The cover both shields the detectors from external light, and also provides 
a consistent low reflectivity to light from PURLS.  Note however that the reflectivity is 
not zero, and executing auto-adjust without the cover, even with no external light, would 
not give the same results.  

Auto-Adjust Procedure 
• Clean the PURLS window. 
• Clean any severe contamination or loose particles from the inside of the 

window cover. 
• Place the window cover over the window and secure with its built-in screws. 
• Check that the PURLS is fully warmed up and both the Output Ready and 

Thermal Control Ready indicators are lit. 
• Press the Start button (or click the auto-adjust button in the Igor control panel) 
• The yellow In Progress light will flash until the process is complete.  You can 

cancel auto-adjust before it completes by pressing the Start button again, or 
selecting Cancel Operation from the PURLS menu in Igor. 

3.5 Cleaning 
 The PURLS output window must be kept clean for consistent results.  The 
window is glass and can safely be cleaned with an optical-quality cleaner such as 
Edmund Lens Cleaner, or lab-grade pure ethanol.  Do not use acetone, because that 
would damage the plastic frame around window. 

3.6 Packing and Shipping 
 PURLS is integrated into a rugged shipping case that meets ATA regulations for 
checked baggage.  However sufficiently severe shocks and vibration can still conceivably 



- 15 - 

damage the PURLS contents.  We recommend transportation via an air freight service, 
such as FedEx Express or DHL, that uses reasonable care in handling. 

 The removable lid of PURLS has a storage compartment that can be used to store 
cables, adapter collars, and other small accessories.  Be careful to provide padding for 
items in the compartment, and double-check that both latches of the compartment are 
securely closed to avoid possible damage to PURLS from loose items. 

 Always ship PURLS with the window cover securely fastened in place. 
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4 CONTROL SOFTWARE 

4.1 Igor Pro Overview 
 IGOR Pro from Wavemetrics, Inc. is an extremely powerful data processing and 
display program that can also be customized and extended with its built-in programming 
environment.  We take advantage of these features to collect and handle PURLS data.  
Igor runs on both Windows and Mac OS platforms, and our customizations also run on 
both platforms. 

 Although it is not necessary in order for you to work with PURLS, we 
recommend you review the introductory material in Igor’s online help for an overview of 
its capabilities, which will enhance your use of the PURLS routines. 

Igor Experiments 
 Igor organizes work into files called experiments.  An experiment can contain 
various types of data, graphics, programs, and text files.  When working with PURLS this 
means you can gather multiple datasets or even entire cruises in one experiment, although 
you are not required to do so.  But the ability to compare and contrast data within a single 
experiment is often very useful. 

Igor Graphs 
 Igor is especially capable at producing publication-quality graphs, and the graphs 
produced by our routines can easily be modified by the user to serve scientific needs as 
well as personal preferences. 

Reduced and Full Menus 
 Igor Pro includes many menu options for using its tremendous data analysis 
capabilities, but few of these are required for routine PURLS operation.  PURLS adds a 
“Reduce Menus” command to the Misc menu, which hides menus you are unlikely to 
use.  You can select “Show All Menus” from the Misc menu to restore the original 
menus. 

Window Recreation Macros 
 When you close a graph or table in Igor, it usually presents a dialog box asking 
whether to save a recreation macro.  A recreation macro is a program Igor can run to 
exactly reproduce the window, including any modifications you’ve made to its style, 
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colors, axes, etc.  However it does not store the actual data, only instructions on how to 
display the data.  So for example if you recreate a graph that displayed PURLS reference 
data, and you continued collecting more data while the graph was closed, the new data 
will be displayed (and the graph will remain “live,” showing new data in real time). 

 Often you will not want to save a recreation macro, and if you would like to skip 
the query about it, hold down the Alt key (in Windows) or Option key (in Mac OS) while 
clicking on the window’s close box. 

Terminal Window 
 The terminal window shows and records all the raw data sent between the 
computer and PURLS.  Anything you type while the terminal window is active will be 
sent directly to PURLS. 

 The PURLS terminal window is an Igor “Notebook,” meaning it is an editable 
text document.  You can save its contents in a text file by selecting File->Save Notebook 
when it is the active window.  You can also use Igor’s Notebook menu to adjust its font 
settings.  You can even directly edit its contents, but you can only control the position of 
the text cursor if the window is not currently receiving data from PURLS. 

 If you close the Terminal Window, Igor will ask whether you want to “kill” or 
hide it.  Killing the window means discarding any contents that have not been saved to 
disk, whereas hiding it will leave it actively collecting data that will be visible if you 
reopen it. 

4.2 PURLS Control Reference 

4.2.1 PURLS Menu (in the Igor menu bar) 
• Show Control Panel is self-explanatory 
• Connect… searches for a PURLS on all 

available ports and at various baud rates.  
Duplicates the function of the Connect check 
box in the control panel. 

• Disconnect ceases communication with PURLS 
• Show Terminal opens the PURLS terminal 

window, or brings it to the front if it is already 
open. 

• Set Clock… sets the PURLS clock to match that of the host computer, after 
asking the user to confirm this is OK. 
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• Cancel Operation needed only in special circumstances, this halts various 
time-consuming PURLS operations, and also halts automatic collection of 
status data, or any other repeating command option (same as the STOP 
command described in section 5).  

• Send Control-Z is similar to Cancel Operation. 
• About PURLS Control displays the version number of the current software 

file. 

4.2.2 Control Panel 

Connect button 
 When you check the 
Connect checkbox, Igor will scan 
all available serial ports, 
searching for a PURLS unit.  
This will not interfere with ports 
that are being used by other 
software.  Occasionally PURLS 
may not be detected if it is 
transmitting data while the 
software is searching.  In these 
cases it will usually be detected 
by a second scan. 

Open Terminal button 
 Opens the terminal 
window, or if it is already open, 
brings it to the front. 

Collect Ref and Temp Data check box 
 If this option is checked, PURLS will automatically send status reports that are 
used to update the displays of the control panel, and add data to the record of temperature 
and reference readings.  The time of the latest received update is displayed below this 
control, so you can verify that the current displayed data are up to date.  You might need 
to turn off this option if you wish to interact with PURLS directly through the terminal 
window. 
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Thermal Control On check box 
 This is a display-only indicator of whether the PURLS thermal controller is 
active.  This is normally true whenever PURLS is powered, unless turned off by a 
firmware command. 

Thermal Control Stable check box 
 This is also a display-only indicator.  The temperature is considered stable when it 
has stayed within 0.3 C of the target value for at least one minute. 

Temperature Error 
 Temperature error is the difference between the actual temperature of the 
regulator’s temperature sensor and the target set point, which is normally 25 C. 

PCB Temperature 
 This is the temperature of the electronic circuitry which is outside the regulated 
portion of PURLS. 

Block Temperature 
 This is a secondary temperature measurement within the thermally-regulated part 
of the light source, but at a different location from the primary sensor used to regulate the 
temperature.  It may show some variation in response to ambient temperature, but should 
remain approximately at the set point of 25 C. 

Temperature Data menu 
• Graph Opens a graph of the three temperatures versus time.  The temperature 

error is graphed against the left-hand scale, and the other two temperatures 
against the right. 

• Open Table shows the three temperatures and their sample times in a table. 
• Export saves the temperature data as a tab-delimited text file, after allowing 

you to select the file’s name and location. 
• Clear All deletes all temperature data from the experiment. 

Light Source On, Stable, Spectrum 1, Spectrum 2 
 These indicators are set according to the 3-position Spectrum switch on the 
PURLS front panel.  The light source generally requires three minutes to stabilize after 
the switch setting is changed. 
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Global Ref Data menu 
 Global reference data are those collected when all LEDs are operating, as 
distinguished from the LED reference data. 

• Graph Average opens a graph of the average of the four PURLS reference 
detectors. 

• Graph Individuals opens a graph of data from the four reference detectors.  
The four signals are individually auto-scaled to show their full range of 
variation, even though they typically have different overall magnitudes. 

• Open Table displays the reference data and their sample times in a table. 
• Export saves the global reference data in a tab-delimited text file, after 

allowing you to select the file’s name and location. 
• Clear All deletes all the global reference data from the experiment. 

LED Ref Data menu 
• Graph One opens a graph of one LED’s reference readings. 
• Open Slider Graph opens a graph in which you can use a slider control to 

rapidly select which LED’s reference readings are displayed. 
• Open Table displays all the individual reference data in a table. 
• Export saves the data in a tab-delimited text file. 
• Clear All deletes all the LED reference data from the experiment. 

Measure LED Refs button 
 Initiates the measurement of individual LED reference readings, which takes 
about 20 seconds.  During this time, the individual LEDs will be briefly turned off in 
turn, so the PURLS output will not be stable. 

 



- 21 - 

5 FIRMWARE COMMANDS 

PURLS has a large set of commands, and only the small subset needed for common 
applications are explained here.  Further, if you use the HOBI-supplied Igor Pro routines, 
you do not need to know any of these commands. 

 This section includes some commands that are new in version 2.65 of firmware.  
To see which version of the firmware you have, use the VER command.  Contact HOBI 
Labs if you wish to upgrade your firmware. 

 To use these commands you must connect to PURLS with Igor Pro and type them 
into its terminal window, or use any other terminal program that can communicate 
through the serial port. 

 Commands can also be saved in files on the PURLS flash to form scripts.  For 
example one could create a file called UPDATE.CMD with these lines: 

 TIME 

 VIN 

then type UPDATE at the PURLS> prompt, which would cause the time and input 
voltage to be displayed.  One could also type START UPDATE to cause this to execute 
repeatedly. 

BAUD [rate] [STORE] 
 If a valid rate is given, sets serial communication to that baud rate, unless the 
STORE keyword is included.  If STORE is included, it saves the given baud rate to be 
used the next time the system starts up.  Valid values of rate are 9600, 19200, 38400, 
57600 and 115200.  If no rate is supplied, displays the current rate. 

DIR [filespec] [/V] 
 Displays a list of files in the PURLS flash memory.  FileSpec may contain * and ? 
wild cards.  The /V flag causes the directory listing to include modification dates and 
times, as well as a display of the total free space left in the memory.  Without the /V flag, 
only the file names and sizes are displayed. 
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MSG 
 Display the time and text of the most recent message, if any, that was prompted 
by an error.  For example, if the red Warning light flashed, you could send the MSG 
command to see a message indicating the cause of the warning. 

SPEC [spectrumID]
Displays the currently active spectrum number.  This will normally be either 1 or 

2 according to the setting of the spectrum switch on the PURLS front panel, or 0 if the 
switch is set to dark.  If a valid spectrumID is specified, this command will set the 
spectrum and override the panel switch.  A spectrumID is valid if a corresponding 
SPECX.LED file, where X is the spectrumID, exists in the PURLS flash. 

START [period] [command…] [?] 
 Command is any valid PURLS command, possibly including arguments and flags.  
START causes the given command to repeat at the given period, or if no period is 
specified, the period entered by a previous command.  START ? prompts a display of the 
period and command specified in a previous START command, if any. 

STOP or control-C or control-Z 
 Stops any repeating command initiated by the START command.  It can also halt 
some time-consuming operations such as auto-adjustment of the LEDs.  The single-key 
control-C works best in cases where the typing of STOP might be interrupted by the 
operation you are attempting to stop. 

TIME [hh:mm:ss] [mm/dd/yy] 
 Displays the current date and time, and sets the clock if the date or time is 
specified.  You may enter either the date, time, or both, as long as you enter them in the 
format specified. 

TYPE [filename] 
 Sends the contents of the given file (if it exists) to the terminal. 

VER 
 Displays the current firmware version. 

VIN 
 Shows PURLS’s internal regulated DC supply voltage, normally 12 V. 
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WARMUP 
Indicates the status of PURLS’ thermal regulation.  If it is stable, it will reply 

 Warmup: READY 10:23:18 

where the time given is the time at which it first reached its stable point.  If it is not yet 
ready, it will indicate how far the temperature is from its set point, for example 

 Warmup: temp. -2.1 from setpoint., 

or if the temperature is stable but the light source has not yet fully stabilized, it will 
indicate how much time remains before it will be ready.  For example: 

 Warmup: light stable in 2.8 min. 

Note that the temperature may appear to hover very close to the set point (within a few 
tenths of a degree) for some time before it is considered stable.  Typically this phase will 
only last one minute, but in some cases it may require several minutes. 
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